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Introducing the VCS
application agent for
Exchange
This chapter contains the following topics:
■

“About the VCS application agent for Exchange” on page 10

■

“VCS application agent for Microsoft Exchange” on page 10

■

“How the agent makes Microsoft Exchange highly available” on page 13

■

“Setting up an Exchange cluster” on page 16
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About the VCS application agent for Exchange
Microsoft Exchange server provides a reliable and scalable messaging and
collaboration infrastructure. The VCS application agent for Microsoft Exchange
provides high availability for Microsoft Exchange in a VCS cluster.
This manual provides instructions on installing the VCS agent for Microsoft
Exchange 2003, and making Microsoft Exchange 2003 highly available in an
Active-Passive configuration.
For detailed instructions on deploying HA and Disaster Recovery solutions for
Microsoft Exchange 2003, see the Veritas Storage Foundation™ and High
Availability Solutions HA and Disaster Recovery Solutions Guide for Microsoft
Exchange.
For more information on the VCS agent for Microsoft Exchange 2007 and
detailed instructions on deploying HA and Disaster Recovery solutions for
Microsoft Exchange 2007, see the Veritas Storage Foundation™ and High
Availability Solutions HA and Disaster Recovery Solutions Guide for Microsoft
Exchange 2007.

VCS application agent for Microsoft Exchange
The VCS application agent for Microsoft Exchange monitors Exchange services
and Exchange protocol servers in a VCS cluster, brings them online, and takes
them offline.
The VCS application agent for Microsoft Exchange contains two agents:
■

Exchange Service agent—Monitors core Exchange services.

■

Exchange Protocol agent—Monitors Exchange protocol servers configured
under the Exchange protocol services.

Both agents work in conjunction to provide high availability for Microsoft
Exchange.
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Exchange Service agent
The Exchange Service (ExchService) agent brings the following Exchange
services online, monitors their status, and takes them offline:
■

Microsoft Exchange Information Store (MSExchangeIS): The Exchange
storage used to hold messages in users’ mailboxes and in public folders.

■

Microsoft Exchange System Attendant (MSExchangeSA): The Exchange
component responsible for maintenance and ensuring that operations run
smoothly.

■

Microsoft Exchange Message Transfer Agent (MSExchangeMTA): The
Exchange component responsible for routing messages.

■

Microsoft Exchange Routing Engine (RESvc): The Exchange routing engine
service.

■

Microsoft Exchange Management Service (MSExchangeMGMT): Provides
Exchange management information through WMI.

Each Microsoft Exchange service is configured as a VCS resource of type
ExchService.
Note: The agent does not support the Active Directory Connector and the Site
Replication Service. Do not run these services on systems that are part of the
VCS Exchange cluster.

Agent Operations
■

Online—Starts the configured Exchange service.

■

Offline—Stops the configured Exchange service.

■

Monitor—Determines the state of the configured Exchange service by
querying the Service Control Manager (SCM).

Note: The agent verifies the state of the enabled databases (databases that are
automatically mounted when the service starts up). If an enabled database is
dismounted, the agent returns UNKNOWN state. The VCS application agent for
Microsoft Exchange monitors only the enabled databases. To enable databases,
run Microsoft Exchange System Manager and clear the Do not mount this store
at start-up check box in database properties. If the agent detects that an enabled
database is not mounted, it returns an UNKNOWN state. So, to disable the
database, check the Do not mount this store at start-up check box if you want to
dismount a database.
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Exchange Protocol agent
The Exchange Protocol (ExchProtocol) agent starts, stops, and monitors
Exchange protocol servers configured under the following Exchange protocols:
■

Post Office Protocol (POP3SVC): Internet messaging protocol used to access
email from a remote location.

■

Simple Mail Transfer Protocol (SMTPSVC): TCP/IP protocol used to transfer
email over the internet, which is also the native mail transport in Microsoft
Exchange.

■

Internet Message Access Protocol (IMAP4SVC): Internet messaging protocol
used to access email messages stored on a remote server.

■

World Wide Web (W3SVC): World Wide Web service.

The agent can monitor multiple virtual servers. Each virtual server to be
monitored is configured as a VCS resource of type ExchProtocol.

Agent Operations
■

Online—Starts the configured Exchange protocol servers.

■

Offline—Stops the configured Exchange protocol servers.

■

Monitor—Determines the state of the configured Exchange protocol servers.
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How the agent makes Microsoft Exchange highly
available
The VCS application agent for Microsoft Exchange detects an application failure
if a configured Exchange service is not running or if a configured Exchange
protocol server is not available. When this occurs, the Exchange service group is
failed over to the next available system in the service group’s SystemList. The
configured Exchange services and Exchange protocol servers are started on the
new system, thus ensuring continuous availability for Exchange data, including
configured mailboxes.

Typical Exchange configurations in a VCS cluster
The VCS application agent for Microsoft Exchange does not support an
Active/Active configuration for Exchange. The agent supports the
Active/Passive and the Any-to-Any configurations. The agent also supports the
Disaster Recovery configuration.

Active-Passive failover configuration
An Active-Passive setup involves one to one failover capabilities. For instance, if
you have two nodes (SYSTEM1 and SYSTEM2), the service group configured on
SYSTEM1 can fail over to SYSTEM2.
In an Active-Passive configuration, one or more Exchange virtual servers can
exist in a cluster, but each server must be managed by a service group
configured with a distinct set of nodes in the cluster.
In a typical two-node configuration, the Microsoft Exchange Server and the VCS
application agent for Microsoft Exchange are installed on both nodes. The
Exchange database is on shared storage.

13
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Figure 1-1
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Any-to-Any failover configuration
In an Any-to-Any configuration, each Exchange virtual server in the cluster can
be configured in a separate service group. Each service group can fail over to any
configured node in the cluster, provided that no other Exchange virtual server is
online on that node. In other words, you must ensure that an Exchange service
group does not fail over to a node on which another Exchange service group is
online.
Figure 1-2

Any-to-Any failover configuration
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For example, consider a three-node cluster hosting two Exchange virtual
servers, EVS1 and EVS2. The virtual servers are configured in VCS in two
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service groups such that nodes 1 and 2 host the EVS1 service group and nodes 2
and 3 host the EVS2 service group. If node 1 (or node 3) fails, the service group
containing the EVS resources is failed over to node 2.

Disaster recovery configuration
A Disaster Recovery (DR) configuration enables you to restore application data
and services in the event of a catastrophic failure. A typical DR solution requires
primary and secondary sites, and clusters within those sites. The cluster at the
primary site provides data and services during normal operation, and the cluster
at the secondary site provides data and services if the primary site fails.
Figure 1-3
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The illustration displays an environment that is prepared for a disaster with a
DR solution. In this case, the primary site is replicating its application data to
the secondary site.
When a failure occurs, such as an earthquake that destroys the data center in
which the primary site resides, the DR solution is activated. The data that was
replicated to the secondary site is used to restore the application services to
clients.
For more information about setting up an Any-to-Any or a Disaster Recovery
configuration, see the Veritas Storage Foundation™ and High Availability
Solutions HA and Disaster Recovery Solutions Guide for Microsoft Exchange.
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Setting up an Exchange cluster
Setting up an Exchange cluster in a VCS environment involves the following
tasks:
■

Installing the VCS agent for Microsoft Exchange.
See “Installing the VCS application agent for Exchange” on page 17 for
instructions.

■

Setting up a VCS cluster.
See “Configuring the cluster” on page 20.

■

Installing Microsoft Exchange.
See “Installing Microsoft Exchange” on page 37 for instructions.

■

Configuring the Exchange service group.
See “Configuring the Exchange service group” on page 65 for instructions.

Each task is described in detail in subsequent chapters.

Chapter

2

Installing the VCS
application agent for
Exchange
This chapter contains the following topics:
■

“About installing the VCS application agent for Exchange” on page 18

■

“Before installing the VCS agent for Exchange” on page 18

■

“Installing the VCS application agent for Exchange” on page 19

■

“Configuring the cluster” on page 20
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About installing the VCS application agent for
Exchange
This chapter describes how to install the VCS application agent for Microsoft
Exchange, provided it was not selected while installing SFW HA. The agent is
installed using the installer for Veritas Storage Foundation and HA for
Windows. The installer installs the agent on selected systems in the cluster and
adds the ExchService and the ExchProtocol resource types to the cluster
configuration.
Complete these steps if you did not install the agent while installing SFW HA.

Before installing the VCS agent for Exchange
This section lists the prerequisites for installing VCS application agent for
Microsoft Exchange in a VCS cluster.
■

Verify that you have SFW HA 5.1 installed on all cluster nodes. Refer to the
Veritas Storage Foundation and High Availability Solutions for Windows,
Installation and Upgrade Guide for instructions.

■

Verify that you have local administrator privileges on the node where you
are installing the agent.

Caution: The VCS application agent for Microsoft Exchange changes the active
computer name in the registry of the active system to the virtual computer
name. When this occurs, you may not be able to use applications that depend on
the active computer name until you take the Exchange agent offline on the
system. For best results, do not install additional applications that rely on the
active computer name.
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Installing the VCS application agent for Exchange
Complete these steps on all systems on which you wish to configure Exchange
with VCS.
To install the VCS application agent for Exchange
1

Start Windows Add/Remove Programs, click Storage Foundation HA 5.1 for
Windows - HA (Server Components) and click Change.

2

In the Storage Foundation 5.1 for Windows dialog box, choose the Add or
Remove option and click Next.

3

In the Storage Foundation HA options panel, click Next.

4

Check Veritas Cluster Server Application Agent for Exchange and click
Next.
The disk space required for the installation is displayed towards the bottom
of the screen. When you add or remove an option, the total space changes.

5

The installer validates the system for prerequisites. After the system is
accepted, click Next.
If a system is rejected, the Comments column displays the cause for
rejecting the system. Highlight the system to view a detailed information
about the failure in the Details box. Resolve the error, highlight the system
from the list, and click Validate Again.

6

An informational message appears if you selected the DMP option. Review
the information and click OK to continue.

7

Review the summary of your selections and click Update to start the
installation. The installer displays the status of installation.

8

After the installation is complete, review the installation report, click Next
and then click Finish.
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Configuring the cluster
After installing the agent, set up the components required to run a cluster. The
VCS Cluster Configuration Wizard (VCW) sets up the cluster infrastructure,
including LLT and GAB, and configures Symantec Product Authentication
Service in the cluster. The wizard also configures the ClusterService group,
which contains resources for the Cluster Management Console (Single Cluster
Mode), also referred to as the Web Console, notification, and global clusters.
Complete the following tasks before configuring a cluster:
■

Verify that each node uses static IP addresses (DHCP is not supported) and
name resolution is configured for each node.

■

Set the required permissions:
■

You must have administrator privileges on the system where you run
the wizard. The user account must be a domain account.

■

You must have administrative access to all systems selected for cluster
operations. Add the domain user to the Local Administrators group of
each system.

■

If you plan to create a new user account for the VCS Helper service, you
must have Domain Administrator privileges or belong to the Domain
Account Operators group.

■

When configuring a user account for the VCS Helper service, make sure
that the user account is a domain user. The VCS HAD, which runs in the
context of the local system built-in account, uses the VCS Helper
Service user context to access the network. This account does not
require domain admin privileges.

■

Make sure the VCS Helper Service domain user account has “Add
workstations to domain” privilege enabled in the Active Directory.

To configure a VCS cluster
1

Start the VCS Cluster Configuration Wizard.
Click Start > All Programs > Symantec > Veritas Cluster Server >
Configuration Tools > Cluster Configuration Wizard.

2

Read the information on the Welcome panel and click Next.

3

On the Configuration Options panel, click Cluster Operations and click
Next.
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4

On the Domain Selection panel, select or type the name of the domain in
which the cluster resides and select the discovery options.

To discover information about all systems and users in the domain:
■

Clear the Specify systems and users manually check box.

Click Next.
Proceed to step 8 on page 23.
To specify systems and user names manually (recommended for large
domains):
■

■

Check the Specify systems and users manually check box.
Additionally, you may instruct the wizard to retrieve a list of systems
and users in the domain by selecting appropriate check boxes.

■

Click Next.
If you chose to retrieve the list of systems, proceed to step 6 on page 22.
Otherwise, proceed to the next step.
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5

On the System Selection panel, type the name of each system to be added,
click Add, and then click Next. Do not specify systems that are part of
another cluster.

Proceed to step 8 on page 23.
6

On the System Selection panel, specify the systems to form a cluster and
then click Next. Do not select systems that are part of another cluster.
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Enter the name of the system and click Add to add the system to the
Selected Systems list, or click to select the system in the Domain Systems
list and then click the > (right-arrow) button.
7

The System Report panel displays the validation status, whether Accepted
or Rejected, of all the systems you specified earlier.
A system can be rejected for any of the following reasons:
■

System is not pingable.

■

WMI access is disabled on the system.

■

Wizard is unable to retrieve the system architecture or operating
system.

VCS is either not installed on the system or the version of VCS is
different from what is installed on the system on which you are
running the wizard.
Click on a system name to see the validation details. If you wish to include a
rejected system, rectify the error based on the reason for rejection and then
run the wizard again.
Click Next to proceed.
■

8

On the Cluster Configuration Options panel, click Create New Cluster and
click Next.

9

On the Cluster Details panel, specify the details for the cluster and then
click Next.
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Cluster Name

Type a name for the new cluster. Symantec recommends a
maximum length of 32 characters for the cluster name.

Cluster ID

Select a cluster ID from the suggested cluster IDs in the
drop-down list, or type a unique ID for the cluster. The
cluster ID can be any number from 0 to 255.
Caution: If you chose to specify systems and users manually in
step 4 on page 21 or if you share a private network between more
than one domain, make sure that the cluster ID is unique.

Operating System

From the drop-down list, select the operating system that
the systems are running.

Available Systems

Select the systems that will be part of the cluster.
The wizard discovers the NICs on the selected systems. For
single-node clusters with the required number of NICs, the
wizard prompts you to configure a private link heartbeat. In
the dialog box, click Yes to configure a private link
heartbeat.
Check the Select all systems check box to select all the
systems simultaneously.

10 The wizard validates the selected systems for cluster membership. After the
systems are validated, click Next.
If a system is not validated, review the message associated with the failure
and restart the wizard after rectifying the problem.
If you chose to configure a private link heartbeat in step 9 on page 23,
proceed to the next step. Otherwise, proceed to step 12 on page 27.
11 On the Private Network Configuration panel, configure the VCS private
network and click Next.
Do one of the following:
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■

To configure the VCS private network over Ethernet

■

Select the check boxes next to the two NICs to be assigned to the
private network.
Symantec recommends reserving two NICs exclusively for the
private network. However, you could lower the priority of one NIC
and use the low-priority NIC for public and private
communication.

■

If you have only two NICs on a selected system, it is recommended
that you lower the priority of at least one NIC that will be used for
private as well as public network communication.
To lower the priority of a NIC, right-click the NIC and select Low
Priority from the pop-up menu.

If your configuration contains teamed NICs, the wizard groups
them as "NIC Group #N" where "N" is a number assigned to the
teamed NIC. A teamed NIC is a logical NIC, formed by grouping
several physical NICs together. All NICs in a team have an identical
MAC address. Symantec recommends that you do not select
teamed NICs for the private network.
The wizard will configure the LLT service (over Ethernet) on the selected
network adapters.
■
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■

To configure the VCS private network over the User Datagram Protocol
(UDP) layer

■

Check the Configure LLT over UDP check box.

■

Specify a unique UDP port in the Port number for Link1 and Port
number for Link2 fields. You can use ports in the range 49152 to
65535. The default ports numbers are 50000 and 50001
respectively.

■

Select the check boxes next to the two NICs to be assigned to the
private network. Symantec recommends reserving two NICs
exclusively for the VCS private network.

■

For each selected NIC, verify the displayed IP address. If a selected
NIC has multiple IP addresses assigned, double-click the field and
choose the desired IP address from the drop-down list. Each IP
address can be in a different subnet.
The IP address is used for the VCS private communication over the
specified UDP port.

For each selected NIC, double-click the respective field in the Link
column and choose a link from the drop-down list. Specify a
different link (Link1 or Link2) for each NIC. Each link is associated
with a UDP port that you specified earlier.
The wizard will configure the LLT service (over UDP) on the selected
network adapters. The specified UDP ports will be used for the private
network communication.
■
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12 On the VCS Helper Service User Account panel, specify the name of a
domain user for the VCS Helper Service. The VCS HAD, which runs in the
context of the local system built-in account, uses the VCS Helper Service
user context to access the network. This account does not require domain
admin privileges.

■

To specify an existing user, do one of the following:
■

Click Existing user and select a user name from the drop-down list,

■

If you chose not to retrieve the list of users in step 4 on page 21,
type the user name in the Specify User field, and then click Next.

To specify a new user, click New user and type a valid user name in the
Create New User field, and then click Next.
Do not append the domain name to the user name; do not type the user
name as DOMAIN\user or user@DOMAIN.

■

■

In the Password dialog box, type the password for the specified user
and click OK, and then click Next.

13 On the Configure Security Service Option panel, specify security options for
the cluster and then click Next.
Do one of the following:
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■

To use the single sign-on feature

Click Use Single Sign-on. In this mode, VCS uses SSL encryption
and platform-based authentication. The VCS engine (HAD) and
Veritas Command Server run in secure mode.
For more information about secure communications in a cluster, see
the Veritas Storage Foundation and High Availability Solutions Quick
Start Guide for Symantec Product Authentication Service.
■

■

If you know the name of the system that will serve as the root
broker, click Specify root broker system, type the system name,
and then click Next.
If you specify a cluster node, the wizard configures the node as the
root broker and other nodes as authentication brokers.
Authentication brokers reside one level below the root broker and
serve as intermediate registration and certification authorities.
These brokers can authenticate clients, such as users or services,
but cannot authenticate other brokers. Authentication brokers
have certificates signed by the root.
If you specify a system outside of the cluster, make sure that the
system is configured as a root broker; the wizard configures all
nodes in the cluster as authentication brokers.

■

If you want to search the system that will serve as root broker,
click Discover the root broker systems in the domain and click
Next. The wizard will discover root brokers in the entire domain,
by default.
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■

If you want to define a search criteria, click Scope. In the Scope of
Discovery dialog box, click Entire Domain to search across the
domain, or click Specify Scope and select the Organization Unit
from the Available Organizational Units list, to limit the search to
the specified organization unit. Use the Filter Criteria options to
search systems matching a certain condition.
For example, to search for systems managed by a user
Administrator, select Managed by from the first drop-down list, is
(exactly) from the second drop-down list, type the user name
Administrator in the adjacent field, click Add, and then click OK.
Table 2-1 contains some more examples of search criteria.

Table 2-1

Search criteria examples

1st drop-down 2nd drop-down Adjacent field Search result
list value
list value
entry
Name

is (exactly)

*system

Displays all systems with names
that end with system.

Name

is (exactly)

*vcsnode*

Displays all systems with names
that contain vcsnode.

Operating
System

is (exactly)

*2003*

Displays all Windows Server 2003
systems.

Operating
System

is (exactly)

*Enterprise*

Displays all Windows Server 2003
Enterprise Edition systems.

Operating
System Version

is (exactly)

5.*

Displays all systems whose
operating system version is 5.x,
where x could be 0, 1, 2, etc.

You can add multiple search criterion; the wizard will search for
systems that match ALL the conditions specified.
Click Next. The wizard discovers and displays a list of all the root
brokers. Click to select a system that will serve as the root broker
and then click Next.
If the root broker is a cluster node, the wizard configures the other
cluster nodes as authentication brokers. If the root broker is outside
the cluster, the wizard configures all the cluster nodes as
authentication brokers.
■
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■

To use VCS user privilege:

■

Click Use VCS User Privileges.
The default user name for the VCS administrator is admin and the
default password is password. Both are case-sensitive. You can
accept the default user name and password for the VCS
administrator account or type a new name and password.
It is recommended that you specify a new user name and password.
Use this account to log on to VCS using Cluster Management
Console (Single Cluster Mode) or Web Console, when VCS is not
running in secure mode.

■

Click Next.

14 Review the summary information on the Summary panel, and click
Configure. The wizard configures the VCS private network.
If the selected systems have LLT or GAB configuration files, the wizard
displays an informational dialog box before overwriting the files. In the
dialog box, click OK to overwrite the files. Otherwise, click Cancel, exit the
wizard, move the existing files to a different location, and rerun the wizard.
The wizard starts running commands to configure VCS services. If an
operation fails, click View configuration log file to see the log.
15 On the Completing Cluster Configuration panel, click Next to configure the
ClusterService service group; this group is required to set up components for
the Cluster Management Console (Single Cluster Mode) or Web Console,
notification, and for global clusters.

Installing the VCS application agent for Exchange
Configuring the cluster

To configure the ClusterService group later, click Finish.
At this stage, the wizard has collected the information required to set up the
cluster configuration. After the wizard completes its operations, with or
without the ClusterService group components, the cluster is ready to host
application service groups. The wizard also starts the VCS engine (HAD) and
the Veritas Command Server at this stage.
Note: After configuring the cluster you must not change the names of the
nodes that are part of the cluster. If you wish to change a node name, run
this wizard to remove the node from the cluster, rename the system, and
then run this wizard again to add the system to the cluster.
You are not required to configure the Cluster Management Console (Single
Cluster Mode) or Web Console, for this HA environment. Refer to the Veritas
Cluster Server Administrator’s Guide for complete details on VCS Cluster
Management Console (Single Cluster Mode), and the Notification resource.
The GCO Option applies only if you are configuring a Disaster Recovery
environment and are not using the Disaster Recovery wizard. The Disaster
Recovery chapters discuss how to use the Disaster Recovery wizard to configure
the GCO option.
16 On the Cluster Service Components panel, select the components to be
configured in the ClusterService service group and click Next.

■

Check the Web Console checkbox to configure the Cluster Management
Console (Single Cluster Mode), also referred to as the Web Console.
See “Configuring Web console” on page 32.
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■

Check the Notifier Option checkbox to configure notification of
important events to designated recipients.
See “Configuring notification” on page 33.

Configuring Web console
This section describes steps to configure the VCS Cluster Management Console
(Single Cluster Mode), also referred to as the Web Console.
To configure the Web console
1

On the Web Console Network Selection panel, specify the network
information for the Web Console resources and click Next.

■

If the cluster has a ClusterService service group configured, you can
use the IP address configured in the service group or configure a new IP
address for the Web console.

■

If you choose to configure a new IP address, type the IP address and
associated subnet mask.

■

Select a network adapter for each node in the cluster. Note that the
wizard lists the public network adapters along with the adapters that
were assigned a low priority.

2

Review the summary information and choose whether you want to bring the
Web Console resources online when VCS is started, and click Configure.

3

If you chose to configure a Notifier resource, proceed to:
“Configuring notification” on page 33.
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Otherwise, click Finish to exit the wizard.

Configuring notification
This section describes steps to configure notification.
To configure notification
1

On the Notifier Options panel, specify the mode of notification to be
configured and click Next.

You can configure VCS to generate SNMP (V2) traps on a designated server
and/or send emails to designated recipients in response to certain events.
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2

If you chose to configure SNMP, specify information about the SNMP
console and click Next.

■

Click a field in the SNMP Console column and type the name or IP
address of the console. The specified SNMP console must be MIB 2.0
compliant.

■

Click the corresponding field in the Severity column and select a
severity level for the console.

■

Click ‘+’ to add a field; click ‘-’ to remove a field.

■

Enter an SNMP trap port. The default value is “162”.
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3

If you chose to configure SMTP, specify information about SMTP recipients
and click Next.

■

Type the name of the SMTP server.

■

Click a field in the Recipients column and enter a recipient for
notification. Enter recipients as admin@example.com.

■

Click the corresponding field in the Severity column and select a
severity level for the recipient. VCS sends messages of an equal or
higher severity to the recipient.

■

Click + to add fields; click - to remove a field.
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4

On the Notifier Network Card Selection panel, specify the network
information and click Next.

■

If the cluster has a ClusterService service group configured, you can
use the NIC resource configured in the service group or configure a new
NIC resource for notification.

■

If you choose to configure a new NIC resource, select a network adapter
for each node in the cluster. The wizard lists the public network
adapters along with the adapters that were assigned a low priority.

5

Review the summary information and choose whether you want to bring the
notification resources online when VCS is started.

6

Click Configure.

7

Click Finish to exit the wizard.
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■
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About installing Microsoft Exchange
This chapter describes how to install and configure Microsoft Exchange and its
components in a VCS cluster.
Note: If you have set up a non-clustered Exchange server (standalone setup), and
you want to make it highly available, refer to the Veritas Storage Foundation™
and High Availability Solutions HA and Disaster Recovery Solutions Guide for
Microsoft Exchange for instructions.
Installing Microsoft Exchange in a VCS cluster involves three major steps;
pre-installation, Microsoft Exchange installation, and post-installation. The
Exchange Setup Wizard for VCS performs the pre-installation and
post-installation steps.

Before installing Microsoft Exchange
■

Verify SFW HA 5.1 is installed in the cluster along with the VCS application
agent for Microsoft Exchange. If a previous version of SFW HA exists,
upgrade it. Refer to the Veritas Storage Foundation and High Availability
Solutions for Windows, Installation and Upgrade Guide for instructions.

■

Verify you have configured a VCS cluster using VCS Cluster Configuration
Wizard (VCW).
See “Configuring the cluster” on page 20.

■

Verify the Veritas High Availability Engine (HAD) is running on the node
where you will install Microsoft Exchange.

■

Verify all systems in the cluster have adequate resources to run the
Microsoft Exchange server and VCS.

■

Verify the DNS and Active Directory Services are available. Make sure that a
reverse lookup zone is created in the DNS. Refer to Microsoft Exchange
documentation for instructions on creating a reverse lookup zone.

■

Verify the Dynamic Update option for the DNS server is set to "Secure Only."

■

Verify DNS settings for all systems on which Microsoft Exchange will be
installed.

■

Verify all systems on which Microsoft Exchange server is to be installed
have IIS installed; the SMTP, NNTP, and WWW services must be installed on
all systems. For installing Exchange on Windows Server 2003, ASP.NET
service must also be installed.
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■

VCS requires Microsoft Exchange to be installed on the same local drive on
all nodes. For example if you install Exchange on drive C of one node,
installations on all other nodes must be on their respective C drives. Make
sure that the same drive letter is available on all nodes and has adequate
space for the installation.

■

Before installing Microsoft Exchange in a VCS cluster, make sure that the
forest and the domain have been prepared. See the Microsoft Exchange
documentation for instructions.

■

Symantec recommends that you have a minimum of four volumes on shared
disks (or volumes on cluster disk groups), one each for the following:
■

Exchange database

■

Registry replication information

■

Transaction logs for the first storage group

MTA data
If you mount these volumes as folders, make sure that the folders are on
shared disks too.
See “Managing storage using SFW” on page 43 for instructions on creating
disk groups and volumes using SFW.
■

Note: If your storage devices are SCSI-3 compliant, and you wish to use
SCSI-3 Persistent Group Reservations (PGR), you must enable SCSI-3
support using the Veritas Enterprise Administrator (VEA - Control Panel System Settings). See the Veritas Storage Foundation Administrator’s Guide
for more information.
■

Verify that the volumes created to store the registry replication database are
mounted on the node where you install Microsoft Exchange and unmounted
from other nodes in the cluster.
See “Mounting volumes” on page 50.
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Supported software
■

Microsoft Exchange servers and their operating systems. Note that all
systems must be running the same operating system:
For Exchange 2003:
Microsoft Exchange Server
2003 Standard Edition or
Enterprise Edition (SP2
required)

■

Windows Server 2003 (32-bit) Standard Edition,
Enterprise Edition, or Datacenter Edition (SP2
required for all editions)

■

Windows Server 2003 (32-bit) R2 Standard
Edition, Enterprise Edition, or Datacenter
Edition (SP2 required for all editions)

■

Windows Server 2003 x64 Standard Edition or
Enterprise Edition (SP2 required for all editions)

■

Windows Server 2003 R2 x64 Standard Edition,
Enterprise Edition (SP2 required for all editions)

■

Windows Server 2008 x64 Editions (for AMD64
or Intel EM64T): Standard x64 Edition,
Enterprise x64 Edition, or Datacenter x64
Edition

For Exchange 2007:
Microsoft Exchange Server
2007 (SP1 supported on
Windows Server 2003, SP1
required on Windows Server
2008), Standard Edition or
Enterprise Edition (Mailbox
server role only)

Note: The instructions in this agent guide are specific to Exchange 2003
only. For configuring an HA and DR environment for Exchange 2007, refer
to the Veritas Storage Foundation and High Availability Solutions HA and
Disaster Recovery Solutions Guide for Exchange 2007.
■

Veritas Storage Foundation HA 5.1 for Windows (SFW HA)

Privileges requirements
■

You must be a domain user.

■

You must be an Exchange Full Administrator.

■

You must be a member of the Exchange Domain Servers group.

■

You must be a member of the Local Administrators group on all nodes on
which Microsoft Exchange will be installed. Make sure to enable write
permissions for objects corresponding to these nodes in the Active
Directory.
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■

You must have write permissions on the DNS server to perform DNS
updates.

■

You must be an Enterprise Administrator, Schema Administrator, Domain
Administrator, or Local Administrator to run ForestPrep; you must be a
Domain Administrator or Local Administrator to run DomainPrep. Refer to
the Microsoft documentation for permissions requirements during
Microsoft procedures that do not involve Symantec wizards.

■

Make sure the VCS Helper Service domain user account has “Add
workstations to domain” privilege enabled in the Active Directory.

■

If a computer object corresponding to the Exchange virtual server exists in
the Active Directory, you must have delete permissions on the object.

■

The same user, or a user with the same privileges must perform the
pre-installation, installation, and post-installation phases for Microsoft
Exchange.

Configuring the network and storage
Use the following procedures to configure the hardware and verify DNS
settings. Repeat this procedure for every node in the cluster.
To configure the hardware
1

Install the required network adapters, and SCSI controllers or Fibre Channel
HBA.

2

Connect the network adapters on each system.
■

To prevent lost heartbeats on the private networks, and to prevent VCS
from mistakenly declaring a system down, Symantec recommends
disabling the Ethernet autonegotiation options on the private network
adapters. Contact the NIC manufacturer for details on this process.

■

Symantec recommends removing TCP/IP from private NICs to lower
system overhead.

3

Use independent hubs or switches for each VCS communication network
(GAB and LLT). You can use cross-over Ethernet cables for two-node
clusters. LLT supports hub-based or switch network paths, or two-system
clusters with direct network links.

4

Verify that each system can access the storage devices. Verify that each
system recognizes the attached shared disk and that the attached shared
disks are visible.

For Windows Server 2003, use the following procedure.
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To verify the DNS settings and binding order for Windows Server 2003
systems
1

Open the Control Panel (Start>Control Panel).

2

Double-click Network Connections, or right-click Network Connections and
click Open.

3

Ensure the public network adapter is the first bound adapter:
■

From the Advanced menu, click Advanced Settings.

■

In the Adapters and Bindings tab, verify the public adapter is the first
adapter in the Connections list. If necessary, use the arrow button to
move the adapter to the top of the list.

■

Click OK.

4

In the Network and Dial-up Connections window, double-click the adapter
for the public network.
When enabling DNS name resolution, make sure that you use the public
network adapters, and not those configured for the VCS private network.

5

In the Public Status dialog box, in the General tab, click Properties.

6

In the Public Properties dialog box, in the General tab:
■

Select the Internet Protocol (TCP/IP) check box.

■

Click Properties.

7

Select the Use the following DNS server addresses option.

8

Verify the correct value for the IP address of the DNS server.

9

Click Advanced.

10 In the DNS tab, make sure the Register this connection’s address in DNS
check box is selected.
11 Make sure the correct domain suffix is entered in the DNS suffix for this
connection field.
12 Click OK.
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Managing storage using SFW
Veritas Storage Foundation for Windows (SFW) manages data by creating disk
groups from physical disks. These disk groups are further divided into volumes,
which can be mounted from the cluster nodes.
Symantec recommends that you create four volumes, one each for Exchange
database, registry replication information, transaction logs for the first storage
group, and MTA data. These volumes must be accessible from all cluster nodes.
Note: If your storage devices are SCSI-3 compliant, and you wish to use SCSI-3
Persistent Group Reservations (PGR), you must enable SCSI-3 support using the
Veritas Enterprise Administrator (VEA - Control Panel - System Settings). See the
Veritas Storage Foundation Administrator’s Guide for more information.
Perform the following tasks to create volumes and make them accessible from
cluster nodes:
■

Create disk groups.
See “Creating disk groups” on page 43.

■

Import disk groups.
See “Importing disk groups” on page 45.

■

Create volumes on disk groups.
See “Creating volumes” on page 45.

■

Mount volumes.
See “Mounting volumes” on page 50.

Creating disk groups
This section describes how to create disk groups and volumes using the Veritas
Enterprise Administrator (VEA) console installed with SFW. Symantec
recommends creating a disk group for every storage group when configuring
Microsoft Exchange. This is also an opportunity to grow existing volumes, add
storage groups, and add databases for existing storage groups.
Note: You must have an external, basic disk to create a cluster disk group.
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To create a dynamic (cluster) disk group
Note: Dynamic disks belonging to a Microsoft Disk Management Disk Group do
not support cluster disk groups.
1

Open the VEA console by clicking Start > All Programs > S ymantec >
Veritas Storage Foundation > Veritas Enterprise Administrator and select a
profile if prompted.

2

Click Connect to a Host or Domain.

3

In the Connect dialog box, select the host name from the pull-down menu
and click Connect.
To connect to the local system, select localhost. Provide the user name,
password, and domain if prompted.

4

To start the New Dynamic Disk Group wizard, expand the tree view under
the host node, right click the Disk Groups icon, and select New Dynamic Disk
Group from the context menu.

5

In the Welcome screen of the New Dynamic Disk Group wizard, click Next.

6

Provide information about the cluster disk group:

■

Enter the name of the disk group (for example, EVS1_SG1_DG).

■

Click the checkbox for Create cluster group.
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■

Select the appropriate disks in the Available disks list, and use the Add
button to move them to the Selected disks list.
Optionally, check the Disk names prefix checkbox and enter a disk
name prefix to give the disks in the disk group a specific identifier. For
example, entering TestGroup as the prefix for a disk group that
contains three disks creates TestGroup1, TestGroup2, and TestGroup3
as internal names for the disks in the disk group.

Note: For Windows Server 2003, Windows Disk Management Compatible
Dynamic Disk Group creates a disk group that is compatible with the disk
groups created with Windows Disk Management and with earlier versions
of Volume Manager for Windows products.
For Windows Server 2008, Windows Disk Management Compatible
Dynamic Disk Group creates a type of disk group that is created by
Windows Disk Management (LDM).
■

Click Next.

7

Click Next to accept the confirmation screen with the selected disks.

8

Click Finish to create the new disk group.

Importing disk groups
1

From the VEA Console, right-click a disk name in the dynamic group or the
dynamic group name in the General tab or tree view.

2

Click Import Dynamic Disk Group from the menu.

3

In the Import Dynamic Disk Group dialog box, click OK.

Creating volumes
To ensure that the drive letters you assign to the new volumes will always be
available on all nodes, assign drive letters starting in the middle of the alphabet.
This way when drive letters are assigned as additional internal devices are
added to a node there will not be a conflict with the volume drive letters.
To create dynamic volumes
1

If the VEA console is not already open, click Start > All Programs >
Symantec > Veritas Storage Foundation > Veritas Enterprise Administrator
and select a profile if prompted.

2

Click Connect to a Host or Domain.

3

In the Connect dialog box select the host name from the pull-down menu
and click Connect.
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To connect to the local system, select localhost. Provide the user name,
password, and domain if prompted.
4

To start the New Volume wizard, expand the tree view under the host node
to display all the disk groups. Right click a disk group and select New
Volume from the context menu.
You can right-click the disk group you have just created, for example
EVS1_SG1_DG.

5

At the New Volume wizard opening screen, click Next.

6

Select the disks for the volume. Make sure the appropriate disk group name
appears in the Group name drop-down list.

7

Automatic disk selection is the default setting. To manually select the disks,
click the Manually select disks radio button and use the Add and Remove
buttons to move the appropriate disks to the “Selected disks” list. Manual
selection of disks is recommended.
You may also check Disable Track Alignment to disable track alignment for
the volume. Disabling Track Alignment means that the volume does not
store blocks of data in alignment with the boundaries of the physical track
of the disk.

8

Click Next.
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9

Specify the volume attributes.

■

Enter a volume name. The name is limited to 18 ASCII characters and
cannot contain spaces or forward or backward slashes.

■

Select a volume layout type. To select mirrored striped, click both the
Mirrored checkbox and the Striped radio button.

■

If you are creating a striped volume, the Columns and Stripe unit size
boxes need to have entries. Defaults are provided.

■

Provide a size for the volume.

■

If you click on the Max Size button, a size appears in the Size box that
represents the maximum possible volume size for that layout in the
dynamic disk group.

■

In the Mirror Info area, select the appropriate mirroring options.

10 In the Add Drive Letter and Path dialog box, assign a drive letter or mount
point to the volume. You must use the same drive letter or mount point on
all systems in the cluster. Make sure to verify the availability of the drive
letter before assigning it.
■

To assign a drive letter, select Assign a Drive Letter, and choose a drive
letter.

47

48 Installing Microsoft Exchange
Managing storage using SFW

■

To mount the volume as a folder, select Mount as an empty NTFS
folder, and click Browse to locate an empty folder on the shared disk.

11 Click Next.
12 Create an NTFS file system.

■

Make sure the Format this volume checkbox is checked and click NTFS.

■

Select an allocation size or accept the Default.
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■

The file system label is optional. SFW makes the volume name the file
system label.

■

Select Perform a quick format if you want to save time.

■

Select Enable file and folder compression to save disk space. Note that
compression consumes system resources and performs encryption and
decryption, which may result in reduced system performance.

■

Click Next.

13 Click Finish to create the new volume.
14 Repeat these steps to create the log volume (EVS1_SG1_LOG) in the
EVS1_SG1_DG disk group. (The EVS1_SG1_LOG volume resides on its own
disk.) Also, repeat these steps to create any additional volumes required.
Create the cluster disk group and volumes on the first node of the cluster
only.
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Mounting volumes
Before installing Microsoft Exchange server, mount the volumes created to store
the registry replication information. Unmount the volumes from other systems
in the cluster.
Mounting a volume involves importing the disk group and assigning a drive
letter or the folder path. Unmounting a volume involves removing the drive
letter or the folder path and deporting the disk group.
To mount a volume
1

Open the Veritas Enterprise Administrator. (Start > All Programs >
Symantec > Veritas Storage Foundation > Veritas Enterprise Administrator)

2

If the disk group is not imported, import it. From the VEA console’s tree
view, right-click the disk group and then click Import Dynamic Disk Group.

3

Right-click the volume, and then click File System > Change Drive Letter
and Path.

4

On the Drive Letter and Paths dialog box, click Add.

5

In the Assign drive letter dialog box, select one of the following options
depending on whether you want to assign a drive letter to the volume or
mount it as a folder, and click OK.
■

To assign a drive letter
Click Assign a Drive Letter and select a drive letter from the drop-down
list.

■

To mount the volume as a folder
Click Mount as an empty NTFS folder and click Browse to locate an
empty folder on the shared disk.

Repeat these steps for all the volumes to be mounted.
To unmount a volume and deport the dynamic disk group
1

Open the Veritas Enterprise Administrator if it is not already open. (Start >
All Programs > Symantec > Veritas Storage Foundation > Veritas Enterprise
Administrator)

2

From the VEA console’s tree view, right-click on the volume, and then click
File System > Change Drive Letter and Path.

3

On the Drive Letter and Paths dialog box, click Remove and click OK.

4

Repeat step 2 and step 3 for all the volumes to be unmounted.

5

From the VEA console’s tree view, right-click the disk and then click Deport
Dynamic Disk Group.
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Installing Exchange on first node
The tasks to be performed on the first node are described in three stages.
Exchange pre-installation, Exchange installation, Exchange post installation.

Exchange pre-installation: first node
Use the Exchange Server Setup Wizard for Veritas Cluster Server to complete
the pre-installation phase. This process changes the physical name of the node
to a virtual name.
Note: After you have run the wizard, you will be requested to restart the node.
Close all open applications and save your data before running the wizard.

To perform Exchange pre-installation
1

Verify the volume created to store the registry replication information is
mounted on this node and unmounted from other nodes in the cluster.

2

Click Start > Programs > Symantec > Veritas Cluster Server >Configuration
Tools > Exchange Server Setup Wizard to start the Exchange Setup Wizard
for VCS.

3

Review the information in the Welcome dialog box and click Next.

4

In the Available Option dialog box, choose the Install Exchange Server for
High Availability option and click Next.

5

In the Select Option dialog box, choose the Create a new Exchange Virtual
Server option and click Next.

6

The wizard validates the system for prerequisites. Various messages
indicate the validation status. Once all the validations are done, click Next.
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7

Specify information related to the network.

■

Enter a unique virtual name for the Exchange server.

Warning: Once you have assigned a virtual name to the Exchange server,
you cannot change the virtual name later. To change the virtual name, you
must uninstall Exchange from the VCS environment and again install it
using the Exchange Setup Wizard for VCS.
■

Enter a domain suffix for the virtual server.

■

Select the appropriate public NIC from the drop-down list. The wizard
lists the public adapters and low-priority TCP/IP enabled private
adapters on the system.

■

Enter a unique virtual IP address for the Exchange virtual server.

■

Enter the subnet mask for the virtual IP address.

■

Click Next.
The installer verifies that the selected node meets the Exchange
requirements and checks whether the Exchange virtual server is
unique on the network.

8

Select a drive where the registry replication data will be stored and click
Next.

9

Review the summary of your selections and click Next.

10 A warning message appears indicating, that the system will be renamed and
rebooted when you exit the wizard. Click Yes to continue.
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11 The wizard starts running commands to set up the VCS environment.
Various messages indicate the status of each task. After all the commands
are executed, click Next.
12 Click Reboot.
The wizard prompts you to reboot the node. Click Yes to reboot the node.
Warning: After you reboot the node, the name specified for the Exchange
virtual server is temporarily assigned to the node. After installing Microsoft
Exchange, you must rerun this wizard to assign the original name to the
node.
On rebooting the node, the Exchange Server Setup wizard is launched
automatically with a message that Pre-Installation is complete. Review the
information in the wizard dialog box and proceed to installing Microsoft
Exchange Server.
Do not click Continue at this time. Wait until after the Exchange installation
is complete.
If you wish to undo all actions performed by the wizard during the
pre-installation procedure, click Revert.

Exchange server installation: first node
Install Exchange on the node where the Exchange Server Setup Wizard was run
for the pre-installation tasks.
Exchange 2003 requires service pack 2. The procedure below is based on
Exchange 2003 SP2.
This is a standard Microsoft Exchange Server installation. Refer to the Microsoft
documentation for details on this installation.
To install Exchange
1

Install Exchange Server using the Microsoft Exchange installation program.
See the Microsoft Exchange documentation for instructions.

2

Reboot the node if prompted to do so.

3

For Exchange 2003, install the required service pack.
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Exchange post-installation: first node
After completing the Microsoft Exchange installation, use the Exchange Setup
Wizard for Veritas Cluster Server to complete the post-installation phase. This
process reverts the node name to the physical name, and sets the Exchange
services to manual so that the Exchange services can be controlled by VCS.
To perform Exchange post-installation
1

Make sure that the Veritas High Availability Engine (HAD) is running on the
node on which you plan to perform the post-installation tasks.
Type the following on the command line:
C:\>hasys -state

The state should display as RUNNING.
If HAD is not running, start it. Type the following on the command line:
C:\>net stop had
C:\>net start had

2

Make sure the registry replication volume is online and mounted on the
node on which you plan to perform the post-installation tasks.

3

If the Exchange installation did not prompt you to reboot the node, click
Continue from the Exchange Setup Wizard and proceed to step 5 on page 54.
If you reboot the node after Microsoft Exchange installation, the Exchange
Setup Wizard is launched automatically.

4

Review the information in the Welcome dialog box and click Next.

5

A message appears indicating that the system will be renamed and restarted
after you quit the wizard.This sets the node back to its physical host name.
Click Yes to continue.

6

The wizard starts performing the post-installation tasks. Various messages
indicate the status. After all the commands are executed, click Next.

7

Click Finish.

8

The wizard prompts you to reboot the node. Click Yes to reboot the node.
Changes made during the post-installation steps do not take effect till you
reboot the node.
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Moving Exchange database to shared storage
After completing Microsoft Exchange installation on the first node, move the
Exchange databases from the local drive of the first node to a location on shared
storage.

Prerequisites
■

Make sure that there is no queued data on the SMTP server.

■

Make sure that the volumes created to store the Exchange database, the
MTA data, and the transaction logs are mounted. Unmount the volumes
from other nodes in the cluster.

To move Exchange databases
1

Click Start > Programs > Symantec > Veritas Cluster Server > Configuration
Tools > Exchange Server Setup Wizard to start the Exchange Setup Wizard
for VCS.

2

Review the information in the Welcome dialog box and click Next.

3

In the Available Option dialog box, choose the Configure/Remove highly
available Exchange Server option and click Next.

4

In the Select Option dialog box, choose the Move Exchange Databases
option and click Next.

55

56 Installing Microsoft Exchange
Moving Exchange database to shared storage

5

In the Select Exchange Virtual Server dialog box:

■

Select the Exchange virtual server.

■

If desired, click Advanced to specify details for the Lanman resource.
■

Select the distinguished name of the Organizational Unit for the
virtual server. By default, the Lanman resource adds the virtual
server to the default container "Computers."

Warning: The user account for VCS Helper service must have adequate
privileges on the specified container to create and update computer
accounts.

6

■

Click OK.

■

Specify whether you want to move the Exchange databases to a default
or custom location. Choosing a custom location allows you to specify
the Exchange database and streaming path.

■

Click Next.

Do one of the following:
■

If you would like to move the first mailbox store, public store, and MTA
data to the generated default paths on the volumes for these
components, proceed to the next step.

■

Otherwise, proceed to step 8 on page 58 to specify the path location on
the volumes that you will designate for these components.
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Warning: The Exchange data files and the MTA must be in different paths,
and the MTA cannot be at the root level (for example K:\).
7

For the option of a default database location, specify the drives where the
Exchange database components will be moved. The database components
will be moved to a default location on that drive. In the Exchange Database
Components dialog box:

■

Specify the drive where the Exchange database will be moved.

■

Specify the drive where the Exchange Transaction Logs will be moved.

■

Specify the drive where the Exchange MTA Data will be moved.

■

Click Next and proceed to step 9 on page 58.

57

58 Installing Microsoft Exchange
Moving Exchange database to shared storage

8

For the option of a custom database location, specify the location for specific
Microsoft Exchange data components. In the Exchange Database
Components dialog box:

For each data component to be moved select the component and specify the
path to which the component is to be moved. Click the ellipsis (...) to browse
for folders. Click Next.
Make sure the path for the Exchange database components contains only
ANSI characters.
9

Review the summary of your selections and click Next.

10 The wizard performs the tasks to move the Exchange databases. Messages
indicate the status of each task. After all the tasks are completed
successfully, click Next.
11 Click Finish to exit the wizard.
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Installing Exchange on additional nodes
After moving the Exchange databases to shared storage, install Exchange on
additional nodes in the cluster for the same Exchange virtual server. You must
run the pre-installation, installation, and post-installation procedures on each
additional node.

Exchange pre-installation: additional nodes
Use the Exchange Server Setup Wizard for Veritas Cluster Server to complete
the pre-installation phase. This process changes the physical name of the node
to a virtual name.
Note: Before adding a node to the Exchange cluster, make sure you meet the
prerequisites listed under “Before installing Microsoft Exchange” on page 38.

To perform Exchange pre-installation
1

Make sure that the volume created to store the registry replication
information is mounted on this node and unmounted on other nodes in the
cluster.

2

From the node to be added to an Exchange cluster, click Start > Programs >
Symantec > Veritas Cluster Server > Configuration Tools > Exchange Server
Setup Wizard to start the Exchange Setup Wizard for VCS.

3

Review the information in the Welcome dialog box and click Next.

4

In the Available Option dialog box, choose the Install Exchange Server for
High Availability option and click Next.

5

In the Select Option dialog box, choose the Create a failover node for
existing Exchange Virtual Server option and click Next.

6

Select the Exchange virtual server for which you are adding the failover
node and click Next.

7

The wizard validates the system for the prerequisites. Various messages
indicate the validation status. When the validations are done, click Next.
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8

Specify network information for the Exchange virtual server.

The wizard discovers the Exchange virtual server name and the domain
suffix from the Exchange configuration. Verify this information and
provide values for the remaining text boxes.

9

■

Select the appropriate public NIC from the drop-down list. The wizard
lists the public adapters and low-priority TCP/IP enabled private
adapters on the system.

■

Optionally, enter a unique virtual IP address for the Exchange virtual
server. By default, the text box displays the IP address assigned when
the Exchange Virtual Server (EVS1) was created on the first node. You
should not have to change the virtual IP address that is automatically
generated when setting up an additional failover mode for the virtual
server in the same cluster.

■

Enter the subnet mask for the virtual IP address.

■

Click Next.

Review the summary of your selections and click Next.

10 A message appears informing you that the system will be renamed and
restarted after you quit the wizard. Click Yes to continue.
11 The wizard runs commands to set up the VCS environment. Various
messages indicate the status of each task. After all the commands are
executed, click Next.
12 Click Reboot.
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The wizard prompts you to reboot the node. Click Yes to reboot the node.
Warning: After you reboot the node, the Exchange virtual server name is
temporarily assigned to the node on which you run the wizard. So, all
network connections to the node must be made using the temporary name.
After installing Microsoft Exchange, you must rerun this wizard to assign
the original name to the node.
On rebooting the node, the Exchange Setup wizard is launched
automatically with a message that Pre-Installation is complete. Review the
information in the wizard dialog box and proceed to installing Microsoft
Exchange Server.
Do not click Continue at this time. Wait until after the Exchange installation
is complete.
If you want to undo all actions performed by the wizard during the
pre-installation procedure, click Revert.

Exchange server installation: additional nodes
Install Exchange on the node where the Exchange Server Setup Wizard was run
for the pre-installation tasks.
To install Exchange
■

Install any required service packs.

■

Install the same Exchange version and components on all nodes.

The procedure below is based on Exchange 2003. This is a standard Microsoft
Exchange Server installation. Refer to the Microsoft documentation for details
on this installation.
To install Exchange
1

Begin the Exchange installation for disaster recovery at the command
prompt using the /disasterrecovery option :
<drive letter>:\SETUP\I386\setup.exe
/disasterrecovery
where <drive letter> is the location where the Exchange software is

located.
2

During the wizard, verify or select Disaster Recovery in the Action column
for the Microsoft Exchange, Microsoft Exchange Messaging and
Collaboration services and Microsoft Exchange System Management Tools
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components. Be sure to install the same components on all the nodes in the
cluster.

3

When notified to restore databases from backup and reboot the node after
completing the installation, click OK and complete the Microsoft Exchange
wizard.

4

If prompted to reboot the node, click Yes.

5

For Exchange 2003, install the service packs listed in the requirements.
When installing service packs enter the following from the command line:
SETUP\I386\update.exe /disasterrecovery
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Exchange post-installation: additional nodes
After completing the installation, use the Exchange Server Setup Wizard to
complete the post-installation tasks. This process reverts the name of the node
to its physical name.
After completing the Microsoft Exchange installation, use the Exchange Setup
Wizard for Veritas Cluster Server to complete the post-installation phase. This
process reverts the node name to the physical name.
To perform Exchange post-installation
1

Make sure that the Veritas High Availability Engine (HAD) is running on the
node on which you plan to perform the post-installation tasks.
Type the following on the command line:
C:\>hasys -state

The state should display as RUNNING.
If HAD is not running, start it. Type the following on the command line:
C:\>net stop had
C:\>net start had

2

Make sure that the volume created to store the registry replication
information is mounted on this node and unmounted on other nodes in the
cluster.

3

If the Exchange installation did not prompt you to reboot the node, click
Continue from the Exchange Setup Wizard and proceed to step 5 on page 63.
If you rebooted the node after Microsoft Exchange installation, the
Exchange Setup Wizard is launched automatically.

4

Review the information in the Welcome dialog box and click Next.

5

A message appears informing you that the system will be renamed and
restarted after you quit the wizard. The system will be renamed to the
physical host name. Click Yes to continue.

6

The wizard starts performing the post-installation tasks. Various messages
indicate the status. After the commands are executed, click Next.

7

If service groups are already configured for the EVS, specify whether you
want to add the node to the system list of the service group for the EVS
selected in the Exchange pre-installation step. You can also add nodes to a
system list when configuring or modifying a service group with the
Exchange service group configuration wizard.

8

Click Finish.

9

The wizard prompts you to reboot the node. Click Yes to reboot the node.
Changes made during the post-installation steps do not take effect till you
reboot the node.
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10 If you are using the Disaster Recovery wizard, return to the Disaster
Recovery wizard to continue with disaster recovery configuration.
After installing Exchange Server on all systems that will participate in the
service group, proceed to “Configuring the Exchange service group” on page 65
for instructions on how to configure the service group.

Chapter

Configuring the Exchange
service group
This chapter contains the following topics:
■

“About configuring the Exchange service group” on page 66

■

“Before configuring the Exchange service group” on page 66

■

“Configuring the VCS Exchange service group” on page 69

■

“Verifying the Exchange service group configuration” on page 76
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About configuring the Exchange service group
VCS provides several ways of configuring a service group, including the service
group configuration wizard, Cluster Manager (Java Console), Cluster
Management Console, and the command line. This chapter provides
instructions on configuring an Exchange service group using the Exchange
Server Configuration Wizard and Cluster Manager (Java Console). You must
have VCS administrator privileges to create and configure a service group.

Before configuring the Exchange service group
■

If you have configured Windows Firewall, add the following to the Firewall
Exceptions list:
■

Port 14150 or the VCS Command Server service,
%vcs_home%\bin\CmdServer.exe.
Here, %vcs_home% is the installation directory for VCS, typically
C:\Program Files\Veritas\Cluster Server.

Port 14141
For a detailed list of services and ports used by SFW HA, refer to the Veritas
Storage Foundation and High Availability Solutions for Windows Installation
and Upgrade Guide.
■

■

Verify that a cluster is configured using VCS Cluster Configuration Wizard
(VCW).
See “Configuring the cluster” on page 20.

■

You must be a Cluster Administrator. This user classification is required to
create and configure service groups.

■

You must be a Local Administrator on the node where you run the wizard.

■

Verify your DNS server settings. Make sure a static DNS entry maps the
virtual IP address with the virtual computer name. Refer to the appropriate
DNS document for further information.

■

Verify Microsoft Exchange is installed and configured identically on all
nodes.

■

Verify the Command Server is running on all systems in the cluster.

■

Verify the Veritas High Availability Daemon (HAD) is running on the system
from where you run the wizard.

■

If you are configuring a resource as a folder mount, make sure you also
configure the root folder as a VCS resource and link the two resources.
See “Configuring additional dependencies for folder mounts” on page 68.
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■

Mount the shared volumes created to store the following data; unmount the
volumes from other nodes in the cluster.
■

Exchange database

■

Registry replication information

■

Transaction logs for the first storage group

■

MTA data

Note: If you mount these volumes as folders, make sure that the folders are
on shared disks too. See “Mounting volumes” on page 50 for instructions.
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Configuring additional dependencies for folder mounts
When using the MountV agent to configure a resource as a folder mount, you
must also configure the root folder as a VCS resource and link the two resources.
Before configuring a resource for folder mounts, make sure you have configured
folder mounts using Veritas Enterprise Administrator.
For example, to mount volume VOL1 at the mount path X:\Folder using the
MountV agent:
1

Configure the root folder X: as a MountV resource.
MountV M1 {
MountPath = X:
VMDGResName = V1
VolumeName = V1
}

2

Configure the folder X:\Folder as a MountV resource.
MountV M2 {
MountPath = X:\Folder
VMDGResName = V1
VolumeName = VOL1
}

3

Link the two resources such that the folder mount resource depends on the
root folder resource.
M2 requires M1

In this example, your configuration would look like:
MountV M1 {
MountPath = X:
VMDGResName = V1
VolumeName = V1 }
MountV M2 {
MountPath = X:\Folder
VMDGResName = V1
VolumeName = VOL1}
VMDg V1 {
DiskGroupName = D1 }
M2 requires M1
M1 requires V1
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Configuring the VCS Exchange service group
VCS provides an Exchange Server Configuration Wizard that guides you
through the process of configuring an Exchange service group. The wizard also
modifies and deletes an Exchange service group. This section describes the steps
required to create a new Exchange service group using the wizard.
To modify an existing service group, see “Modifying the service group
configuration” on page 80.
Before configuring the Exchange service group, review the resource types and
the attribute definitions of the Exchange agents.
See Appendix A, “Resource type definitions” on page 99.
For sample configuration files and resource dependency graphs of the Exchange
service group, see Appendix B, “Sample configurations” on page 103.
Note: Symantec recommends that you configure Microsoft Exchange Server and
Microsoft SQL Server on separate failover systems within a cluster.

To configure the Exchange service group
1

Start the Exchange Server Configuration Wizard. Start > Programs >
Symantec > Veritas Cluster Server > Configuration Tools > Exchange Server
Configuration Wizard

2

Review the information in the Welcome dialog box and click Next.

3

In the Wizard Options panel, choose the Create service group option and
click Next.
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4

Specify the service group name and system list:

■

Enter a name for the Exchange service group.
If you are configuring the service group on the secondary site, ensure
that the name matches the service group name on the primary site.

■

In the Available Cluster Systems box, select the systems on which to
configure the service group and click the right-arrow icon to move the
systems to the service group’s system list. Symantec recommends that
you configure Microsoft Exchange Server and Microsoft SQL Server on
separate failover nodes within a cluster.

■

To remove a system from the service group’s system list, select the
system in the Systems in Priority Order list and click the left arrow.

■

To change a node’s priority in the service group’s system list, select the
node in the Systems in Priority Order list and click the up and down
arrows. The node at the top of the list has the highest priority while the
system at the bottom of the list has the lowest priority.

■

Click Next. The wizard starts validating your configuration. Various
messages indicate the validation status.
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5

Verify the Exchange virtual server name and the drives or folder mounts
created to store Exchange data:

■

Specify the Exchange Virtual Server.

■

If desired, click Advanced to specify details for the Lanman resource.
■

Select the distinguished name of the Organizational Unit for the
virtual server. By default, the Lanman resource adds the virtual
server to the default container "Computers." The user account for
VCS Helper service must have adequate privileges on the specified
container to create and update computer accounts.

■

Click OK.

■

Verify the Exchange Database Path.

■

Verify the Transaction Log Path.

■

Specify whether you want to configure the Exchange Management
service.
■

Specify whether you want to configure the Exchange MTA service
resource. The Exchange Message Transfer Agent is specific to
legacy Exchange message routing based on X.400. There are
specific circumstances where it may or may not be required for
your Exchange server. Please refer to Microsoft documentation on
Exchange message routing and the use of MTA for further
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clarification and applicability to its use within your Exchange
environment.
■

■

6

If you are utilizing Symantec Mail Security for Exchange be sure to
indicate that you would like to configure this resource.

Click Next.

Select the check box next to the protocol servers to be monitored and click
Next.
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7

Specify information related to the network:

■

The Virtual IP Address and the Subnet Mask text boxes display the
values entered while installing Exchange. You can keep the displayed
values or enter new values.
If you change the virtual IP address, you must create a static entry in
the DNS server mapping the new virtual IP address to the virtual server
name.

■

For each system in the cluster, select the public network adapter name.
Select the Adapter Name field to view the adapters associated with a
node.

Warning: The wizard displays all TCP/IP enabled adapters on a system,
including the private network adapters, if they are TCP/IP enabled. Make
sure you select the adapters to be assigned to the public network, and not
those assigned to the private network.
■

Click Next.
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8

Review the service group configuration and change the resource names, if
desired:

The Resources box lists the configured resources. Click on a resource to
view its attributes and their configured values in the Attributes box.

9

■

The wizard assigns unique names to resources. Change names of
resources, if desired.
To edit a resource name, select the resource name and either click it or
press the F2 key. Press Enter after editing each resource name. To
cancel editing a resource name, press Esc.

■

Click Next.

■

A message appears informing you that the wizard will run commands
to create the service group. Click Yes to create the service group.
Various messages indicate the status of these commands. After the
commands are executed, the completion dialog box appears.

In the Completing the Exchange Configuration panel, select the Bring the
service group online check box to bring the service group online on the local
system.

10 Click Finish.
After bringing the service group online, you must run the Exchange System
Manager so that all the stores are automatically mounted on start-up.
To reconfigure mounting of stores at start-up
1

Start Exchange System Manager.
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2

In the left pane, navigate to your storage group.
If administrative groups are not configured, Servers > Exchange Server >
Storage Group.
If more than one administrative group is configured, expand
Administrative Groups > Your Administrative Group > Servers > Exchange
Server > Storage Group.

3

Right-click the Exchange database and choose Properties from the pop-up
menu.

4

Click the Database tab.

5

Clear the Do not mount this store at start-up check box.

6

Click OK.

Repeat these steps for all the Exchange databases that were previously
mounted.
If you need to configure additional storage groups or mailbox stores on the
shared storage you should do that now. Import disk groups and mount volumes
that have been created for the additional storage groups or mailbox stores, and
create the new storage groups and mailbox stores in Exchange , and then rerun
the Exchange Configuration Wizard to bring them under VCS control. If you
already designated the additional mounted volumes and disk groups when you
ran the configuration wizard the first time then you can just create the storage
groups and mailbox stores in Exchange .
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Verifying the Exchange service group configuration
This section provides steps to verify an Exchange service group configuration by
bringing the service group online, taking it offline, and switching the service
group to another cluster node.

Bringing the service group online
Perform the following steps to bring the service group online from the VCS Java
or Web Console.
To bring a service group online from the Java Console
1

In the Cluster Explorer configuration tree, select the Exchange service group
to be taken online.

2

Right-click the service group name, and then click Enable Resources. This
enables all resources in the service group.

3

Right-click the service group name, and select the system on which to
enable the service group. (Right-click > Enable > system_name or Right-click
> Enable > All)

4

Save your configuration (File > Close Configuration).

5

Right-click the service group and select to online the service group on the
system. (Right-click > Online > system_name)

To bring a service group online from the Web Console
1

On the Service Group page (Cluster Summary > All Groups > Service Group),
click Online.

2

In the Online Group dialog box, select the system on which to bring the
service group online.

3

To run PreOnline script, select the Run PreOnline Script check box.

4

Click OK.
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Taking the service group offline
Perform the following steps to take the service group offline from the VCS Java
or Web Console.
To take a service group offline from the Java Console
1

On the Service Groups tab of the Cluster Explorer configuration tree,
right-click the service group.
or
Select the cluster in the Cluster Explorer configuration tree, select the
Service Groups tab, and right-click the service group icon in the view panel.

2

Click Offline, and choose the appropriate system from the pop-up menu.
(Right-click > Offline > system_name)

To take a service group offline from the Web Console
1

On the Service Group page (Cluster Summary>All Groups>Service Group),
click Offline. This opens the Offline Group dialog box.

2

Select the system on which to take the service group offline.

3

Click OK.
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Switching the service group
The process of switching a service group involves taking it offline on its current
system and bringing it online on another system. Perform the following steps to
switch the service group from the VCS Java or Web Console.
To switch a service group from the Java Console
1

On the Service Groups tab of the Cluster Explorer configuration tree,
right-click the service group.
or
Select the cluster in the Cluster Explorer configuration tree, select the
Service Groups tab, and right-click the service group icon in the view panel.

2

Click Switch To, and choose the appropriate system from the pop-up menu.
(Right-click > Switch To > system_name)

To switch a service group from the Web Console
1

From the Service Group page (Cluster Summary>All Groups>Service
Group), click Switch.

2

On the Switch Group dialog box, select the system to switch the service
group to.

3

Click OK.
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This chapter contains the following topics:
■

“About administering the Exchange service group” on page 80

■

“Modifying the service group configuration” on page 80

■

“Deleting the Exchange service group” on page 81
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About administering the Exchange service group
This chapter describes administrative tasks such as modifying the service group
configuration or deleting a service group, that you can perform on an Exchange
service group.

Modifying the service group configuration
You can dynamically modify the Exchange service group configuration in
several ways, including the Exchange Server Configuration Wizard, Cluster
Manager (Java Console), Cluster Management Console, and the command line.
The following steps describe how to modify the service group using the
configuration wizard.

Before modifying the service group
■

If the Exchange service group is online, you must run the wizard from a
node on which the service group is online. You can then use the wizard to
add resources to and remove them from the configuration. You cannot
change resource attributes.

■

To change the resource attributes, you must take the service group offline.
However, the MountV and VMDg resources for the service group should be
online on the node where you run the wizard and offline on all other nodes.
So, the volumes created to store the Exchange database, the registry
replication information, the MTA data, and the transaction logs should be
mounted.

■

If you are running the wizard to remove a node from the service group’s
system list, do not run the wizard on the node being removed.
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Instructions
1

Start the Exchange Server Configuration Wizard. (Start > All Programs >
Symantec > Veritas Cluster Server > Configuration Tools > Exchange Server
Configuration Wizard)

2

Read the information on Welcome panel and click Next.

3

On the Wizard Options panel, click Modify service group, select the service
group to be modified, and click Next.

4

Follow the wizard instructions and make desired modifications to the
service group configuration.
See “Configuring the VCS Exchange service group” on page 69.
If you run the wizard to add a system to an online service group, resources
having local attributes may go in an UNKNOWN state for a short duration.
These resources will come out of the UNKNOWN state in the next monitor
cycle.

Deleting the Exchange service group
The following steps describe how to delete an Exchange service group using the
configuration wizard.
To delete an Exchange service group
1

Start the Exchange Server Configuration Wizard from a cluster node. (Start
> All Programs > Symantec > Veritas Cluster Server > Configuration Tools >
Exchange Server Configuration Wizard)

2

Review the information in the Welcome panel and click Next.

3

In the Wizard Options panel, click Delete service group, select the service
group to be deleted and click Next.

4

In the Service Group Summary panel, click Next.

5

A message appears informing you that the wizard will run commands to
delete the service group. Click Yes to delete the service group.

6

Click Finish.
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Removing the VCS agent
for Exchange
This chapter contains the following topics:
■

“About removing the VCS application agent for Exchange” on page 84

■

“Before removing the VCS application agent for Exchange” on page 84

■

“Overview of tasks” on page 84

■

“Removing Microsoft Exchange” on page 85

■

“Removing the Microsoft Exchange application agent” on page 89
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About removing the VCS application agent for
Exchange
The Exchange Server Setup Wizard for VCS removes Microsoft Exchange server
and its components from the local node and must be run from each node on
which Exchange server is installed.
If your configuration has more than one Exchange virtual server (EVS)
configured on each node, you must run the wizard once for each EVS. The
wizard removes Microsoft Exchange server from the node only when you
remove the last EVS on that node.

Before removing the VCS application agent for
Exchange
■

From the Exchange service group SystemList, remove the node where you
are removing Microsoft Exchange.

■

Verify that the user mailboxes and routing group connectors are deleted
from the system where you are removing Microsoft Exchange.

■

Verify that the system from which Microsoft Exchange will be removed is
not a Recipient Update Server.

■

Verify that the system from which Microsoft Exchange will be removed is
not a routing master.

See “Troubleshooting Microsoft Exchange uninstallation” on page 97 to resolve
errors encountered while removing Microsoft Exchange server.

Overview of tasks
Removing the VCS application agent for Microsoft Exchange from a cluster node
involves the following tasks:
■

Removing Microsoft Exchange server from the node using the Exchange
Setup Wizard for VCS.
See “Removing Microsoft Exchange” on page 85.

■

Removing the VCS application agent for Microsoft Exchange.
See “Removing the Microsoft Exchange application agent” on page 89.

Repeat these steps on all nodes from where Microsoft Exchange and VCS
application agent for Microsoft Exchange are to be removed.
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Removing Microsoft Exchange
The Exchange Server Setup Wizard for VCS performs the following tasks for
removing Microsoft Exchange from a node:
■

If the node being removed is configured to host other Exchange virtual
servers, the wizard removes the node from the SystemList of the service
group for the specified Exchange virtual server. The wizard does not remove
Microsoft Exchange from the node.
See “Removing a node without uninstalling Microsoft Exchange” on
page 86.

■

If the node being removed is not configured to host other Exchange virtual
servers, the wizard removes the node from the SystemList of the service
group for the specified Exchange virtual server. The wizard also removes
Microsoft Exchange from the node by launching the Microsoft Exchange
Installation wizard.
See “Removing a node and uninstalling Microsoft Exchange” on page 86.
Note: If you are removing Microsoft Exchange from all nodes in the cluster,
delete the service group after taking it offline.
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Removing a node without uninstalling Microsoft Exchange
1

Start the Exchange Server Setup Wizard for VCS. (Start > All Programs >
Symantec > Veritas Cluster Server > Configuration Tools > Exchange Server
Setup Wizard)

2

Review the information in the Welcome panel and click Next.

3

In the Available Option panel, click Configure/Remove highly available
Exchange Server and click Next.

4

In the Select Option panel, click Remove Exchange Server and click Next. If
an Exchange service group is configured on the node, the wizard prompts
you to remove the system from the service group’s SystemList attribute.
Resolve the error and rerun the Exchange Setup Wizard.

5

Select the Exchange virtual server for which you are removing the failover
node and click Next. The wizard starts running commands to set up the VCS
environment for removing the node from the Exchange service group.
Various messages indicate the status of each command.

6

Once all the commands are executed, click Next.

7

Click Finish.
Proceed to “Removing the Microsoft Exchange application agent” on
page 89 for instructions on uninstalling the agent.

Removing a node and uninstalling Microsoft Exchange
1

Start the Exchange Server Setup Wizard for VCS. (Start > All Programs >
Symantec > Veritas Cluster Server > Configuration Tools > Exchange Server
Setup Wizard)

2

Review the information in the Welcome panel and click Next.

3

In the Available Option panel, click Configure/Remove highly available
Exchange Server and click Next.

4

In the Select Option panel, click Remove Exchange Server and click Next. If
an Exchange service group is configured on the node, the wizard prompts
you to remove the system from the service group’s SystemList attribute.
Resolve the error and rerun the Exchange Setup Wizard.

5

Select the Exchange virtual server for which you are removing the failover
node and click Next.

6

A message appears informing that the system will be renamed and restarted
after you quit the wizard. Click Yes to continue. The wizard starts running
commands to set up the VCS environment for removing the node from the
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Exchange service group. Various messages indicate the status of each
command.
7

Once all the commands are executed, click Next. The wizard prompts you to
choose whether you want to retain the entry for the EVS in the Active
Directory. Click Yes to remove the entry or No to retain the entry.

8

Click Reboot and click Yes when the wizard prompts you to restart the node.
If you have other applications running, click No, close all applications, and
restart the node manually. Restarting the node automatically launches the
Exchange Setup Wizard for VCS.

9

Review the information in the Welcome panel and click Next.

10 A message appears informing that the system will be renamed and restarted
after you quit the wizard. Click Yes to continue.
11 On the Microsoft Exchange Installation Wizard Welcome panel, click Next.
12 In the Component Selection panel, click the Action column against each
Exchange component, select Remove from the drop-down list, and click
Next.

13 In the Installation Summary panel, review the information presented and
click Next. The Component Progress panel displays the status of the
uninstallation.
14 On the completion panel, click Finish. Do not reboot the node at this stage.
The Exchange Setup Wizard for VCS must complete its operations before the
node is rebooted. The Exchange Setup Wizard for VCS is launched. The
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wizard performs the post-uninstallation tasks. Various messages indicate
the status of each task.
15 Once all the tasks are complete, click Next and then click Finish.
16 Click Yes when the wizard prompts you to restart the node. If you have other
applications running, click No, close all applications, and restart the node
manually.
Proceed to “Removing the Microsoft Exchange application agent” on
page 89 for instructions on uninstalling the agent.
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Removing the Microsoft Exchange application agent
Before removing the VCS application agent for Microsoft Exchange, make sure
you meet the following requirements:
■

Verify that you have local administrative privileges on the node from where
you are removing the agent.

■

Verify that all Exchange service groups are offline on all nodes in the
cluster.

To remove the agent
1

Start the installer for Storage Foundation for Windows. In the Add/Remove
Programs applet, click Storage Foundation HA 5.1 for Windows - HA (Server
Components) and click Change.

2

In the Storage Foundation 5.1 for Windows dialog box, click Add or Remove
and click Next.

3

In the SFW product options panel, click Next.

4

Uncheck Veritas Cluster Server Application Agent for Exchange and click
Next. The installer validates the system for prerequisites.

5

After the system is accepted, click Next.
If a system is rejected, the Comments column displays the cause for
rejecting the system. Highlight the system to view a detailed information
about the failure in the Details box. Resolve the error, highlight the system
from the list, and click Validate Again. An informational message appears if
you selected the DMP option. Review the information and click OK to
continue.

6

Review the summary of your selections and click Update to start the
uninstallation. The installer displays the status of uninstallation.

7

After the uninstallation is complete, review the report, click Next, and then
click Finish. Repeat these steps on all systems from where the VCS
application agent for Microsoft Exchange is to be removed.
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Chapter

Troubleshooting
This chapter contains the following topics:
■

“About troubleshooting the VCS agent for Exchange” on page 92

■

“VCS logging” on page 92

■

“Exchange Protocol agent error messages” on page 93

■

“Exchange Service agent error messages” on page 95

■

“Troubleshooting Microsoft Exchange uninstallation” on page 97

■

“Troubleshooting Exchange Setup Wizard issues” on page 98
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About troubleshooting the VCS agent for Exchange
This chapter describes how to troubleshoot common problems in the VCS
application agent for Microsoft Exchange. The chapter lists the error messages,
and describes the problem associated with the agent. Recommended solution is
included, where applicable.

VCS logging
VCS generates two error message logs: the engine logs and the agent logs. Log
file names are appended by letters. Letter A indicates the first log file, B the
second, C the third, and so on.
The agent log is located at %VCS_HOME%\log\agent_A.txt. The format of agent
log messages is:
Timestamp (Year/MM/DD) | Mnemonic | Severity | UMI | Agent Type |
Resource Name | Entry Point | Message Text
The agent log message components are defined as follows:
■

Timestamp denotes the date and time when the message was logged.

■

Mnemonic denotes which Symantec product logs the message. For VCS
application agent for Microsoft Exchange, mnemonic is ‘VCS’.

■

Severity denotes the seriousness of the message. Severity of the VCS error
messages is classified into the following types:
■

CRITICAL indicates a critical error within a VCS process. Contact
Technical Support immediately.

■

ERROR indicates failure of a cluster component, unanticipated state
change, or termination or unsuccessful completion of a VCS action.

■

WARNING indicates a warning or error, but not an actual fault.

■

NOTE informs that VCS has initiated an action.

■

INFO informs about various state messages or comments.
Of these, CRITICAL, ERROR, and WARNING indicate actual errors.
NOTE and INFO provide additional information.

■

UMI or Unique Message ID is a combination of Originator ID, Category ID,
and Message ID. For example, the UMI for a message generated by the
ExchService agent would resemble: V-16-20024-13
Originator ID for all VCS products is ‘V-16.’ Category ID for ExchProtocol
agent is 20023 while that for ExchService agent is 20024. Message ID is a
unique number assigned to the message text.

■

Message text denotes the actual message string.
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You can view these message logs using Notepad or any text editor. All messages
are logged to the engine and the agent logs. Messages of type CRITICAL and
ERROR are also written to the Windows event log.
A typical agent log resembles:
2003/12/19 15:09:22 VCS INFO V-16-20024-13
ExchService:d1-ExchService-MSExchangeIS:online:Service
(MSEXCHANGEIS) is taking longer to start. Timeout = 10 seconds

Exchange Protocol agent error messages
Table 7-2

Exchange Protocol agent error messages

Message

Description

Failed to find the service object. Please
check the 'Protocol' attribute

The value specified for “Protocol” attribute is
incorrect.
Solution: Provide a valid value for the attribute.

Failed to get the Lanman resource state The value specified for the Lanman resource is
incorrect.
Error Type, Error Code. Please check
the 'LanmanResName' attribute.
Solution: Provide a valid value for the Lanman
resource. If the value is correct, see error type
and error code for further information.
Configuration error. 'Protocol' attribute No value specified for the “Protocol” attribute.
is not configured.
Solution: Specify a valid value for the attribute.
Configuration error. 'VirtualServer'
attribute is not configured.

No value specified for the “Virtual Server”
attribute.
Solution: Specify a valid value for the attribute.

Configuration error. 'LanmanResName' No value specified for the “LanmanResName”
attribute is not configured.
attribute.
Solution: Specify a valid value for the attribute.
Failed to find the specified exchange
server (server name) in the active
directory. Error Type, Error Code.

The value specified for the Exchange server
name (lanman resource name) does not pertain
to the Exchange server service group.
Solution: Provide a valid value for the Lanman
resource that pertains to the Exchange server
service group.
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Table 7-2

Exchange Protocol agent error messages (Continued)

Message

Description

Failed to get protocol virtual servers
(Type = protocol type).Error Type, Error
Code.

The value specified for the protocol type and
protocol server do not match.
Solution: Provide a valid combination of
protocol type and protocol server.

Failed to find the specified protocol
The value specified for the protocol virtual
virtual server (server name) Error Type, server is incorrect. See the associated Windows
Error Code. Please check the
error type and error code for more information.
'VirtualServer' attribute.
Failed to initialize active directory
The agent fails to initialize the Active Directory
protocol object. Error Type, Error Code. protocol object. See the associated Windows
error type and error code for more information.
Failed to access the active directory.
Error Type, Error Code.

The agent fails to access the Active Directory.
See the associated Windows error type and
error code for more information.

ADsOpenObject() for obj_name
returned Error Code

The agent fails to open the Active Directory
object. See the associated Windows error code
for more information.

The Lanman resource (Virtual name =
resource name) is offline.

The Lanman resource is offline.

Failed to start the protocol virtual
server (virtual server name). Error
Type, Error Code.

The agent failed to start the protocol virtual
server. See the associated Windows error type
and error code for more information.

Failed to stop the protocol virtual
server (virtual server name). Error
Type, Error Code.

The agent failed to stop the protocol virtual
server. See the associated Windows error type
and error code for more information.

Failed to determine the state of the
protocol virtual server (virtual server
name). Error Type, Error Code.

The agent failed to determine the state of the
protocol virtual server. See the associated
Windows error type and error code for more
information.

Solution: Bring the Lanman resource online.
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Exchange Service agent error messages
Table 7-3

Exchange Service agent error messages

Message

Description

Failed to find the service object. Please
check the 'Service' attribute.

The value specified for the “Service” attribute is
incorrect.
Solution: Provide a valid value for the Lanman
resource. If the value is correct, see error type
and error code for further information.

Configuration error. 'Service' attribute
is not configured.

No value specified for the “Service” attribute.
Solution: Specify a valid value for the attribute.

Configuration error. 'LanmanResName' No value specified for the “LanManResName”
attribute is not configured.
attribute.
Solution: Specify a valid value for the attribute.
Failed to get the Lanman resource state The value specified for the Lanman resource is
incorrect.
Error Type, Error Code. Please check
the 'LanmanResName' attribute.
Solution: Provide a valid value for the Lanman
resource. If the value is correct, see error type
and error code for further information.
The Lanman resource (Virtual name =
resource name) is offline.

The Lanman resource is offline.

Failed to stop the service (service
name). Error Type, Error Code.

The agent failed to stop the service. See the
associated Windows error type and error code
for more information.

Failed to start the service (service
name) Error Type, Error Code.

The agent failed to start the specified service.
See the associated Windows error type and
error code for more information.

Failed to open the service
object.(Service = service name). Error
Type, Error Code.

The agent failed to open the service object. See
the associated Windows error type and error
code for more information.

Failed to initialize the CExchServer
object. Error Type, Error Code.

The agent failed to initialize the Exchange
server object.

Failed to query the service status.
(Service = service name). Error = Error
Type

The agent failed to query the service object. See
the associated Windows error type and error
code for more information.

Solution: Bring the Lanman resource online.
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Table 7-3

Exchange Service agent error messages (Continued)

Message

Description

Failed to terminate the service (service
name). Error Type, Error Code.

The agent failed to terminate the service. See
the associated Windows error type and error
code for more information.

Failed to open the service object
(Service = service name). Error Type,
Error Code.

The agent failed to open the service object. See
the associated Windows error type and error
code for more information.
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Troubleshooting Microsoft Exchange uninstallation
You might encounter errors while removing Microsoft Exchange if any of the
following requirements are not adhered to:
■

User mailboxes exist.

■

The Exchange Server to be uninstalled is a Recipient Update Server.

■

The Exchange Server to be uninstalled is a Routing Group Master.

■

The Exchange Server to be uninstalled has routing group connectors
configured.

In any of the above scenarios, carry out the following steps to resolve the error.
1

Start the following Exchange services manually using the Service Control
Manager:
■

MSExchangeSA

■

MSExchangeIS

■

MSExchangeMTA

■

MSExchangeMGMT

■

RESvc

■

POP3

■

IMAP4

2

Delete user mailboxes by running the Active Directory Users and
Computers MMC wizard (Start > All Programs > Microsoft Exchange >
Active Directory Users and Computers).

3

Delete the routing group connector by running the Exchange System
Manager MMC wizard (Start > All Programs > Microsoft Exchange >
Exchange System Manager).

4

Change the Routing Group Master by running the Exchange System
Manager MMC wizard.

5

Change the Recipient Update Server by running the Exchange System
Manager MMC wizard.

6

Stop all Exchange services started in Step 1.

7

Start the Exchange Setup Wizard for VCS and select the Remove Exchange
option. Note that you must uninstall Exchange only by using the Exchange
Setup Wizard for VCS.
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Troubleshooting Exchange Setup Wizard issues
When adding a failover node to an existing Exchange cluster, the Exchange
Setup Wizard may fail to rename the node during the pre-installation phase, and
report the following error message:
Failed to rename the node. Refer to the log file for further
details.

This can happen if the Exchange Setup Wizard is unable to delete the Exchange
Virtual Server computer object in the Active Directory.
To resolve this issue, you must manually delete the Exchange Virtual Server
computer object from the AD, and run the wizard again.

Appendix

Resource type definitions
This chapter contains the following topics:
■

“About resource type definitions” on page 100

■

“Exchange Service agent” on page 100

■

“Exchange Protocol agent” on page 101
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About resource type definitions
This appendix lists the resource type definitions and attribute definitions of the
Exchange Service and the Exchange Protocol agents.
The resource type represents the VCS configuration definition of the agent and
specifies how the agent is defined in the configuration file main.cf. The
Attribute Definitions lists the attributes associated with the agent. The Required
attributes table lists the attributes that must be configured for the agent to
function properly.

Exchange Service agent
The Exchange Service agent is represented by the ExchService resource type.

Resource type definition
type ExchService (
static i18nstr ArgList[] =
{Service, "LanmanResName:VirtualName", DetailMonitor }
str Service
str LanmanResName
int DetailMonitor = 0
)

Attribute definitions
Review the following information to familiarize yourself with the required agent
attributes for an ExchService resource type. This information will assist you
during the agent configuration.

Table A-4

Exchange Service agent required attributes

Required
Attributes

Type and
Dimension

Definition

Service

string-scalar

The name of the Exchange service to be
monitored. This attribute could take any of the
following values:
■

MSExchangeIS

■

MSExchangeMTA

■

MSExchangeMGMT

■

MSExchangeSA

■

RESvc

Resource type definitions
Exchange Protocol agent

Table A-4

Exchange Service agent required attributes (Continued)

Required
Attributes

Type and
Dimension

Definition

LanmanResName

string-scalar

The name of the Lanman resource on which the
ExchService resource depends.

Table A-5

Exchange Service agent optional attributes

Optional
Attribute

Type and
Dimension

Definition

DetailMonitor

integer-scalar

A flag that determines whether the agent
monitors the MSExchangeIS service in detail.
The value 1 indicates that the agent monitors the
service in detail; the value 0 indicates it does not.
Set this attribute only for resources configured to
monitor the MSExchangeIS service; the attribute
is ignored for other services.

Exchange Protocol agent
The Exchange Protocol agent is represented by the ExchProtocol resource type.

Resource type definition
type ExchProtocol (
static i18nstr ArgList[] =
{ Protocol, VirtualServer, "LanmanResName:VirtualName",
DetailMonitor }
str Protocol
i18nstr VirtualServer
str LanmanResName
int DetailMonitor
)
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Attribute definitions
Review the following information to familiarize yourself with the required agent
attributes for an ExchProtocol resource type. This information will assist you
during the agent configuration.

Table A-6

Exchange Protocol agent required attributes

Required
Attributes

Type and
Dimension

Definition

VirtualServer

string-scalar

The name of the Exchange protocol server to be
monitored. This attribute can take localized
values.

LanmanResName

string-scalar

The name of the Lanman resource on which the
ExchProtocol resource depends.

Protocol

string-scalar

The Exchange protocol for which the Exchange
protocol server is configured. This attribute could
take any of the following values:

Table A-7

■

POP3SVC

■

W3SVC

■

IMAP4SVC

■

SMTPSVC

Exchange Protocol agent optional attributes

Optional
Attribute

Type and
Dimension

Definition

DetailMonitor

integer-scalar

For internal use.

Appendix

Sample configurations
This chapter contains the following topics:
■

“About sample configurations” on page 104

■

“Active-Passive failover configuration” on page 105
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About sample configurations
The sample configurations in this appendix describe typical service groups
configured to monitor the state of the Exchange Server in a VCS cluster.
The appendix lists the sample configuration for clusters using SFW to manage
shared storage.
See “Active-Passive failover configuration” on page 105.
The sample configuration graphically depicts the resource types, resources, and
resource dependencies within the service group. The sample configuration files
(main.cf) are also included for your reference. For more information about these
resource types, see the chapter VCS Resource Types and Agents in the Veritas
Cluster Server Administrator’s Guide.
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Active-Passive failover configuration
This section lists the sample configuration for clusters employing Storage
Foundation for Windows to manage shared storage. In the sample configuration
shown in the dependency graph below, the shared disk group is configured using
the Volume Manager Diskgroup (VMDg) agent.

POP3SVC-Site1

ExchProtocol
IMAP4SVC-Site1

W3SVC-Site1

ExchProtocol

ExchProtocol

ExchProtocol
SMTPSVC-Site1

ExchService_MTA
ExchService

ExchService
ExchService

ExchService_IS
ExchService

ExchService_RESvc
ExchService_SA

ExchService_MGMT

ExchService

RegRep-1
RegRep
Lanman
Lanman-EVS2
MountV-U
MountV

MountV-V
MountV

MountV-S
MountV

MountV-T
MountV

IP
Exch_IP

NIC
NIC-EVS2-GRP

VMDg
VMDg-DG_EVS2

■

Four volumes are mounted as drives T, S, U and V respectively, using the
MountV agent.
The Registry Replication resource, configured to replicate the Exchange
registry keys, is set up on volume T of the cluster disk group. The Exchange
database is installed on volume S. The MTA data is installed on drive V, and
the transaction logs on drive U.

■

The Exchange services (MSExchangeSA, MSExchange RESvc,
MSExchangeIS, MSExchangeMGMT, and MSExchangeMTA) are configured
as resources of type ExchService.
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■

The Exchange virtual servers (SMTPSVC-Site1, W3SVC-Site1,
IMAP4SVC-Site1, and POP3SVC-Site1) are configured as resources of type
ExchProtocol.

■

The virtual name for the server is created using the Lanman resource.
The service group virtual IP address for the server is configured using the IP
and NIC resource types.

Sample configuration file
include "types.cf"
cluster VCSCluster (
UserNames = { admin = "LLfWWb[Y_a]d_eY_e^" }
Administrators = { admin }
CounterInterval = 5
)
system VCSExch1 (
CPUUsageMonitoring = { Enabled = 0, ActionThreshold = 0,
ActionTimeLimit = 0,
Action = NONE,
NotifyThreshold = 0,
NotifyTimeLimit = 0 }
)
system VCSExch2 (
CPUUsageMonitoring = { Enabled = 0, ActionThreshold = 0,
ActionTimeLimit = 0,
Action = NONE,
NotifyThreshold = 0,
NotifyTimeLimit = 0 }
)
group Exch_GRP (
SystemList = { VCSExch1 = 1, VCSExch2 = 2 }
)
VMDg Exch_VMDg (
DiskGroupName = ExchVCSDG
)
ExchProtocol ExchProtocol_IMAP4Svc_Site1 (
Protocol = IMAP4SVC
VirtualServer = "Default IMAP4 Virtual Server"
LanmanResName = Exch_Lanman
)
ExchProtocol ExchProtocol_POP3_Site1 (
Protocol = POP3SVC
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VirtualServer = "Default POP3 Virtual Server"
LanmanResName = Exch_Lanman
)
ExchProtocol ExchProtocol_SMTPSvc_Site1 (
Protocol = SMTPSVC
VirtualServer = "Default SMTP Virtual Server"
LanmanResName = Exch_Lanman
)
ExchProtocol ExchProtocol_W3Svc_Site1 (
Protocol = W3SVC
VirtualServer = "Exchange Virtual Server"
LanmanResName = Exch_Lanman
)
ExchService ExchService_IS (
Service = MSExchangeIS
LanmanResName = Exch_Lanman
DetailMonitor = 1
)
ExchService ExchService_MTA (
Service = MSExchangeMTA
LanmanResName = Exch_Lanman
)
ExchService ExchService_RESvc (
Service = RESvc
LanmanResName = Exch_Lanman
)
ExchService ExchService_SA (
Service = MSExchangeSA
LanmanResName = Exch_Lanman
)
ExchService ExchService_MGMT (
Service = MSExchangeMGMT
LanmanResName = Exch_Lanman
)
IP Exch_IP (
Address = "10.212.102.168"
SubNetMask = "255.255.254.0"
MACAddress @VCSExch1 = "00-02-B3-02-86-1D"
MACAddress @VCSExch2 = "00-02-B3-02-86-35"
)
Lanman Exch_Lanman (
VirtualName = ExchSRV
IPResName = Exch_IP
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DNSUpdateRequired = 1
ADUpdateRequired = 1
ADCriticalForOnline = 1
)
MountV Exch_DB_MountV (
MountPath = "J:"
VolumeName = Exchange
VMDGResName = Exch_VMDg
)
MountV Exch_MTA_MountV (
MountPath = "I:"
VolumeName = Exchange
VMDGResName = Exch_VMDg
)
MountV Exch_TrLog_MountV (
MountPath = "H:"
VolumeName = Exchange
VMDGResName = Exch_VMDg
)
MountV Exch_RegRep_MountV (
MountPath = "G:"
VolumeName = RegRep
VMDGResName = Exch_VMDg
)
NIC Exch_NIC (
MACAddress @VCSExch1 = "00-02-B3-02-86-1D"
MACAddress @VCSExch2 = "00-02-B3-02-86-35"
)
RegRep Exch_RegRep (
MountResName = Exch_RegRep_MountV
ReplicationDirectory = "\\Vcs\\Private\\RegRep\\Exch"
Keys =
{"HKLM\\SYSTEM\\CurrentControlSet\\Services\\MSExchangeSA",
"HKLM\\SYSTEM\\CurrentControlSet\\Services\\MSExchangeIS",
"HKLM\\SYSTEM\\CurrentControlSet\\Services\\MSExchangeMTA",
"HKLM\\SYSTEM\\CurrentControlSet\\Services\\POP3Svc",
"HKLM\\SYSTEM\\CurrentControlSet\\Services\\IMAP4Svc" }
ListOpenKeys = 0
ForceRestore = 0
)
ExchProtocol_IMAP4Svc_Site1 requires ExchService_IS
ExchProtocol_POP3_Site1 requires ExchService_IS
ExchProtocol_SMTPSvc_Site1 requires ExchService_IS
ExchProtocol_W3Svc_Site1 requires ExchService_IS
ExchService_MGMT requires ExchService_SA
ExchService_IS requires ExchService_SA
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ExchService_MTA requires ExchService_SA
ExchService_RESvc requires ExchService_SA
ExchService_SA requires Exch_RegRep
ExchService_SA requires Exch_DB_MountV
ExchService_SA requires Exch_MTA_MountV
ExchService_SA requires Exch_TrLog_MountV
ExchService_SA requires Exch_Lanman
Exch_IP requires Exch_NIC
Exch_Lanman requires Exch_IP
Exch_DB_MountV requires Exch_VMDg
Exch_MTA_MountV requires Exch_VMDg
Exch_TrLog_MountV requires Exch_VMDg
Exch_RegRep_MountV requires Exch_VMDg
Exch_RegRep requires Exch_RegRep_MountV
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